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Introduction

Introduction
Careers and Jobs is designed to help the
counselor get a complete picture of a
student's Career Interests and Job
Related Skills, while at the same time
maintaining focus of the student's
abilities and potential.
Each student takes the Career Interest
and Job Analysis Surveys included in the
program. Based upon this information,
the student may review job and job
related information in his/her highest
areas of interest or need.
The program also helps analyze different
types of skills, educational
requirements, and obstacles the student
may encounter in finding and keeping a
job.
It includes:
• An on screen Career
Analysis Survey.
• Job information for
organized by twelve
interest.
• Student test scores
for comparison with
• and much more...

Interest and Job
over 2500 jobs,
areas of
and transcripts
job interests.

NETWORK READY
It comes Network ready, at no additional
charge. That means one student can be
8
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taking a Career Interest Survey while
another student is viewing those jobs
related to his/her highest area of
interest.
CAREER INTEREST AND JOB INFORMATION
Imagine a student being able to browse
through hundreds of jobs available in
his/her highest Career Interest area.
Then, when an interesting job comes on
the screen, all they have to do is click
one button to print the information to
the printer.
Now, you can! After the student has
taken the survey, all you do is get the
student on the screen. Simply click on
<Career Interest Survey> or <Job
Analysis Survey> to review the survey
results for that student.
From the Career Interest screen, the
student can review his/her scores in
each of the twelve areas of interest.
Then, by clicking one button, he/she can
review jobs specifically related to one
of the twelve areas of interest. While
viewing a job, clicking one button
prints information about that job to the
printer.
From the Job Analysis screen, the
student can view the scores in each of
the four job survey areas: Job
Information, Educational Requirements,
Job Obstacles, and Getting a Job. Again,
by clicking on one button, the student
can review suggestions and helps in any
9
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of the four areas: Job Information,
Educational Requirements, Job Obstacles,
and Getting a Job.
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Chapter 1: Getting Started
Installation
Place the Careers and Jobs Program
Diskette # 1 in your Floppy Drive A (or
B).
Windows 3.X
From the 'File' Menu of the Windows
Program Manager, select Run. Enter the
following:
A:install [Enter]
or
B:install [Enter].
WINDOWS 9x
From the 'Start' button of the Windows
95 task bar, select Run. Enter the
following:
A:install [Enter]
or
B:install [Enter].
Press [Enter] for each option that
appears on the screen. When the program
has been successfully installed, the
final message you'll see will be
"Installation is complete".
First Time You Run the Program
After first installing the program, the
program is running in ‘DEMO’ mode. In
Demo mode, you can test every option in
the program.

11
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Registering the Program
To gain unrestricted access to the
program, you must register it. To
register a program, do the following:
1) Received the Master Diskettes
If you ordered the program from our
office, the registration information
will be on the last master diskette.
Put that diskette in your floppy disk
drive (A or B).
Under the Utilities Menu, select
‘Registration/Support’, then select
‘Register Program’.
By default, the program is set up to
register the program from floppy disk
drive A. If this is what you want to do,
simply select < OK >. Otherwise, select
the appropriate options below.
From the Program Registration Screen:
Select (•) Register Program
( ) Un-Register the Program
Select the program to register:
(•) Careers and Jobs Program
( ) All-In-One Registration
Select the drive where the registration
information is located:
(•) Registration File is in Drive A
( ) Registration File is in Drive B
( ) Other DrivePath (Please specify)
Note: If you select this last option,
you must type in the drive and path
12
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where the registration information is
located. For example: c:\windows\temp
(Be sure to enter the location where the
registration file is located on your
computer.)
2) Registering the Demo program
Downloaded from our Web Site.
If you downloaded the demo program and
want to purchase it, contact our sales
office: 1-800-424-7512 or email us at:
sales@epessoftware.com. When the payment
or purchase order is received, you will
be sent a registration file for the
program. Put that file on a floppy
diskette and follow the same
instructions in step 1 above.
Daily Startup
To start the program, select the Careers
and Jobs icon within the EPES Software
Group of your Windows Program Manager.
Enter your ID: SYS
Password: PASSWORD
This is the ID and Password for the
System Administrator. This person has
complete access to every option in the
program. He/she can also add new users
and assign the rights for those users.
See the 'Administrator Menu' options.
This was the System Administrator ID and
Password originally assigned to the
program. Use the 'Change Password'
13
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option under the Utilities Menu to make
any changes.
Master Menu
File
Edit
Commands
Output
Utilities
Help
Administrator

Window

Each option on the Master Menu is a
chapter in this manual. To locate
information quickly, look at the title
of each page.
Within each chapter, the items under
each Master Menu option are explained in
order from top to bottom. Use the Find
option below to look up key words.
A Quick Overview
WHAT TO DO (CHECKLIST)
1) Change Password for System
Administrator so you have total control
of what happens with your system. Be
sure you keep this password in a safe
place. (Chapter 10)
2) Under the Utilities Menu, select
"Program Preferences". Double check your
printer and printer port selection.
(Chapter 8)
3) Add Student information. (Chapter 3)
4) Add Staff information. (Chapter 3)
5) Add Test Related information.(Chapter
3)
6) Add Subject information. (Chapter 3)
7) Add Transcript information. (Chapter
3)
14
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8) Have students take Career Interest
Survey. (Chapter 3)
9) Have students take Job Analysis
Survey. (Chapter 3)
10) Print Reports. (Chapter 6)

15
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Chapter 2: Getting Around in the
Program
Using the Keyboard and Mouse
You can use the keyboard or mouse with
the program. Keyboard short-cuts can
often save you a lot of time. For
example, you can press [Ctrl+A] while
viewing information on the screen to add
a new entry. Press [Ctrl+S] when you've
finished to save your work.
With the click of a button, a mouse can
accomplish the equivalent of a single
keystroke or many keystrokes on the
keyboard.
To select an item with the mouse, move
the mouse pointer over the desired item.
Click the left mouse button on the
desired item.
Moving Around the Screen
Keyboard
Use the [Tab] key, [Down Arrow] or
[Right Arrow] keys to move to the next
item on the screen.
Use the [Shift+Tab] key, [Up Arrow] or
[Left Arrow] keys to move to the
previous item on the screen.
Mouse
16
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When adding or editing information on
the screen, you can move your cursor to
an item simply by clicking on it with
the left mouse button.
You can change the entire contents of an
item by highlighting it with the mouse.
After the cursor is placed in the item,
double click on the left mouse button to
highlight the entire contents. Then
start typing.
Popup Screens and Lists
Sometimes it's hard to remember what to
enter in a particular field. To simplify
your data entry, you can select a popup
list while adding or editing some
information.
For example, suppose you were entering a
Student ID number. When you come to the
Student ID field, press <Enter>. A list
of names will appear in a scrolling
list. Move your cursor to the column
labeled Name. Begin typing the first few
letters of the student's name. When you
see the name, highlight it and press
<Enter> to select it.
Adding or Editing from a Popup List
Sometimes when you have a popup list on
the screen, the information you're
looking for has not been entered or is
not correct.
To add additional information while
viewing the popup list, press [Ctrl+A].
17
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To edit the information highlighted in
the popup list, press [Ctrl+E].
When you've finished adding or editing
the information, press [Ctrl+S] twice to
save your information.
ToolBar Menu
When you want to Add, Edit, or View
information on the screen, you'll select
one of the options under the File Menu.
At the top of the screen, just under the
Master Menu, the ToolBar Menu will
appear. Each option is represented in a
small box with a written description
underneath it. Use these options to Add,
Edit, or View information on the screen.
To select an option, click on it with
the mouse. There are 15 selections to
choose from:
First Prev Next Last Add Edit Del Find
List Filter Order By More Save Cancel
Close
First
Click this item to go to the first entry
in the file.
Prev
Click this item to go to the previous
entry in the file.
Next
Click this item to go to the next entry
in the file.
18
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Last
Click this item to go to the last entry
in the file.
Add
Click this item to add a new entry. When
you're done, click on "More" to save
this one and add another. Click on
"Save" to quit adding and return to
view.
Edit
Click this item to edit the current
information on the screen.
Del
Click this item to delete the current
information on the screen.
Note: If you have a window at the bottom
of the screen which has the options "New
Change Remove" listed, you'll have to
use "Remove" to delete all the detail
items before you can delete the main
information on the screen.
If you try to delete the information
before using "Remove", a message will
appear and tell you it cannot delete the
information.
Find
Use this option to find information
already typed into the computer. A Find
Window will appear with the following
options:
19
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"Select Field to Search In:"
Press the space bar or click on the down
arrow to the right to select the
specific field you want to look for. For
example, Grade.
"Enter Value to Search For:"
Enter the information you want to search
for. For example, 10.
"[X] Ignore Case
[ ] Exact Match
Only"
If you want to find exactly what you
type in, select Exact Match, otherwise
leave Ignore Case marked.
Find - Use this option to view the
"First" entry for the information you've
just entered.
Browse - Use this option to choose
from a list of entries that contain the
information you've just entered.
Highlight the entry you want and press
<Enter> to view it.
Count - Use this option count how many
times the information you typed in is
found in the file. A count will appear
in the upper right hand corner.
Close - Use this option to close the
"Find Window".
List
Use this option to present multiple
entries in a column and row format.
Normally you'll view about 20 items on
the screen. To get the information to
fill the entire screen, click on the up
20
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arrow in the upper right hand corner of
the screen (Windows 3.x) or click on the
square (Windows 95).
To find an entry in the list, move the
cursor to the field you want to use. For
example, name. Then, begin typing the
first few letters of the name. When you
see the information you want, highlight
it and press <Enter>.
Note: The cursor will only go into
columns where an index is defined. You
will not be able to use this option on
every list column.
Filter
Use this option to limit the information
you view on the screen.
The following example illustrates this
option:
Suppose you want to look at all students
in grade 10. Select "Student" under the
File Menu.
Click on < Filter > with the mouse. A
"Filter" Window will appear with the
following options:
"Select Field to Search In"
Press the space bar or click on the down
arrow to the right to select the
specific field you want to look for. For
example, Grade Id.
"Enter a Search Condition"
21
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Press the space bar or click on the down
arrow to the right to select one of the
following conditions:
Is Equal To
Is NOT Equal TO
Is More Than
Is Less Than
Is Equal To or More Than
Is Less Than or Equal To
"Enter value to Search For"
Enter the specific information you want
to see. For example, to look at all
students in grade 10, enter the number
10.
"[X] Ignore Case
[ ] Exact Match
Only"
If you want to find exactly what you
type in, select Exact Match, otherwise
leave Ignore Case marked.
Set - Use this option to set your
filter. A message will appear in the
upper right hand corner telling you how
many records met your criteria.
Once you close the Filter Window, you'll
only be able to view the information on
the screen that met the criteria you
typed in. In our example, you'd only be
able to view checkout entries for
accession number 1.
The Filter box on the ToolBar Menu will
have a check in it. This indicates a
filter is set.
22
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Clear - Use this option to clear the
filter so you can view all records on
the screen for the file you've selected.
You can also do this same thing by
selecting the "Clear Filter" option
under the Commands Menu.
Close - Use this option to close the
"Filter Window".

Setting Multiple Filters
If you already have a filter set and
select the filter option again, the
following message will appear:
"A filter is in effect. Only records
that match the current filter AND the
new filter criteria will be found. Clear
Filter?"
Yes - Use this option to erase the
current filter.
No - Use this option to keep the
existing filter in tact and add another
filtering condition to it.
For example, we originally set a filter
to look at only students in grade 10.
You could now add a filter for a
homeroom number, say 201. Then, only
students in grade 10, in homeroom number
201 would appear on the screen.
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Cancel - Use this option to exit and
leave the existing filter in place.
Order By
Use this option to select the order in
which information is presented on the
screen. To set the order:
1) Highlight the box under "Order By".
2) Press the spacebar or click on the
arrow to the right of the box to show a
list of fields.
3) Select the field which determines the
order the information will be presented
on the screen.
4) By default, the order will be
Ascending (from lowest to highest). If
you want the order to be Descending
(highest to lowest), click on the down
arrow box to the right of "Order By:".
To change the order back to Ascending,
click on the Up Arrow to the right of
"Order By:"
More
Click this item when you've finished
adding an entry and want to add another
one. The current entry will be saved and
a new screen will appear.
Save
Click this item to save the information
you've just added or edited. You'll then
return to view mode.
24
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Cancel
Click this item to close what you're
doing without saving the information.
Close
Click this item to close the file you've
selected and clear the screen.
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Student
Use this file to enter information about
your students.
Student ID: Each student is assigned a
unique ID number. For example, 1, 2, 3,
etc. Enter a unique ID number for each
student.
Name: Enter the name of the student:
Last, (comma) then first. Notice that
the name is automatically put into upper
case. Don't worry, this is to help make
it easier for you to look up students by
name from a popup list.
Grade ID: Enter the student's grade
level.
Homeroom: Enter the student's homeroom
number.
Parent: Enter the name of the student's
parent or guardian.
Address: Enter the student's address,
city, state, and zip code.
NOTE: If you have student information
already entered into a program at your
school. Check to see if the program can
export specific student information to
an ASCII delimited text file. If so, you
26
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may be able to use the Import option
under the Utilities Menu to enter your
student information.
Career and Interest Survey
This survey consists of 96 questions, on
six pages, with 16 questions per page.
The student should read each question
and rate his/her interest level
according to the following four point
scale.
My Interest Level is:
1) None 2) Little 3) Some

4) High

NOTE: All questions must be answered
before the Career Interest Survey can be
saved. If a question is not answered,
the program will beep and tell the
student all questions must be answered.
After answering all the questions on
Page 1, click on [Page 2] at the bottom
of the screen to answer the next 16
questions. Continue this until all
questions are answered.
Job Analysis Survey
This survey consists of 40 questions, on
four pages, with 10 questions per page.
The student should read each question
and rate his/her perceived difficulty
level according to the following four
point scale.
27
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My Interest Level is:
1) None 2) Little 3) Some
4) High
NOTE: All questions must be answered
before the Job Analysis Survey can be
saved. If a question is not answered,
the program will beep and tell the
student all questions must be answered.
After answering all the questions on
Page 1, click on [Page 2] at the bottom
of the screen to answer the next 10
questions. Continue this until all
questions are answered.
Job Description
This information has already been
entered for you. It is provided here as
a way to review all job areas,
regardless of interest area. You may add
additional jobs, if needed.
When the student is reviewing his Career
Interest Survey, he/she can review jobs
according to one of the twelve interest
areas, but not all areas at once. The
Job Description screen consists of the
following information:
Interest Group Code: This field shows
the major interest area this job belongs
to. There are twelve interest areas.
Job Name: This field contains the job
title.
Job Description: This is a brief
description of the job.
28
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Occupational Codes
Reading Ability: This shows what reading
ability is required for this job.
Math Ability: This shows what math
ability is required for this job.
Language Ability: This shows what
language ability is required for this
job.
Preparation Time: This shows the amount
of time it takes to prepare to work at
this job.
Education: This shows the educational
requirements or degree needed to work at
this job.
Physical Strength: This shows the amount
of physical strength required when
working at this job.
Salary: This gives a range of salary
wages the student can expect to earn
when working at this job.
Outlook: This gives the student an idea
of how many openings there may be for
this job and how long it could take to
successfully get this job.
Click on [Print Job Description] to
print a copy of this job information to
the printer.
Tests
29
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Use this file to enter information about
the tests used in the school.
[Test Id]: Enter a unique ID number for
each test. For example, 1.
[Testtitle]: Enter a descriptive name
for the test. For example, Stanford
Achievement Test.
NOTE: The computer automatically puts
the title in upper case. This is done to
help simplify the selection of the test
from a popup screen.
Testlevel: Enter the level of the test.
Testform: Enter the form of the test.
Copyright: Enter the copyright year for
this test.
Testclasid: Press <F5> to select from a
popup list for type of test.
Test Scores
Use this file to enter test scores for
students.
Student Id: Enter the student's ID
number or press <F5> to select from a
popup list of students.
Test Id: Enter the test ID number or
press <F5> to select from a popup list
of tests.
30
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Test Area Id: Enter the test area for
this test score or press <F5> to select
from a popup list of test areas.
Score: Enter the test score for this
student in this test area.
Date: Enter the date the test was taken.
Testtime: Enter the time of year the
test was given. Use F (fall) or S
(spring) followed by the two digit year.
For example: F98, would mean the fall of
1998.
Staff Id: Enter the staff member's ID
number or press <F5> to select from a
popup list of staff members. This may be
a homeroom teacher or designated teacher
for the given subject.
Test Areas
Use this file to enter information about
the different types of subtests you want
to record test scores for.
Testarea Id: Enter a unique ID for this
test area. For example, BASBT might mean
basic battery. Notice that this
information is automatically put in
upper case by the program. This is to
simplify the selection of a subtest area
from a popup list, when entering student
test scores.
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Tstartitle: Enter a descriptive title
for this subtest area. For example,
Basic Battery.
Subject File
Use this file to enter information about
the subjects offered in your school.
Course Id: Enter the a unique course
number for the course.
Course Title: Enter a descriptive name
for the course.
Credit: Enter the amount of credit
given, per semester, for this course
Max No: Optional. Enter the maximum
number of students allowed in this
course.
Gpa Wgt: Optional. Enter the GPA weight
for this course. For example, a normal
course would be 1.00. However, an honors
course might be 1.25.
Male/Female/Both: Who can take this
course? M=Male, F=Female, B=Both
Priority: Optional. Enter a number from
1 (highest priority) to 9 (lowest
priority) to determine the importance of
this course.
Grade Low: Enter the lowest grade where
this course is offered.
32
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Grade High: Enter the highest grade
where this course is offered.
Staff Id: Enter the Staff Id number for
the teacher of this course.
Semester: Optional. Enter the
semester(s) the course is offered:
1=First, 2=Second, 3=Both.
No. Sect: Optional. Enter the number of
sections for this course.
Hrs Taught: Optional. Enter the number
of hours per day this course is taught.
Transcript
Use this file to enter information about
student transcripts.
Student Id: Enter the student's ID
number. Press <F5> to select from a
popup list.
Grade Id:: Press <Enter> to accept the
default grade or enter the student's
grade.
Course Id: Enter the course Id number.
Press <F5> to select from a popup list.
Semester: Enter the semester this course
was taken.
Lettergrad: Enter the letter grade the
student received for this course.
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GPA Equiv: Enter the GPA equivalent
grade for this letter grade.
Credit Avail: Press <Enter> to accept
the default credit for this semester or
enter the credit available for this
course (this semester).
Credit Earned: Enter the credit the
student earned for this course (this
semester).
Staff
Use this file to enter information about
the staff members in your school.
Staff Id: Enter a unique Id number for
this staff member.
Name: Enter the name of the staff
member. Last, (comma) then first.
NOTE: The name will automatically be put
in upper case. This is to simplify the
lookup and selection of the staff name
from a popup list during data entry.
Soc Sec No: Enter the staff member's
social security number.
Address: Enter the staff member's
address, city, state and zip code.
Phone: Enter the staff member's home
phone number.
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Race Id: Enter the race code for this
staff member: B=Black W=White
H=Hispanic A=Asian I=Indian O=Other.
Gender: Enter M for male or F for
female.
Homeroom: Enter the homeroom number for
this staff member.
Close
Use this option to close the current
file that is displayed on the screen.

Printer Setup
Use this option to select a default
printer or add/remove a printer driver
from your windows operating system. See
your Windows operating instructions for
detailed information.
Exit
Use this option to exit the program.
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Chapter 4: Edit Menu
Use the following commands while adding
or editing information on the screen.
(See note on how to highlight
information below.)
CUT Ctrl+X
Select "Cut" from the Edit Menu or hold
down the Ctrl key and press the letter X
to delete (Cut) highlighted information
in a field on the screen.
COPY Ctrl+C
Select "Copy" from the Edit Menu or hold
down the Ctrl key and press the letter C
to copy highlighted information to the
computer clip board.
PASTE Ctrl+V
Select "Paste" from the Edit Menu or
hold down the Ctrl key and press the
letter V to copy information copied onto
the computer clip board into the current
field on the screen.
NOTE: To highlight information in a
field on the screen:
Using the Keyboard:
1) Move the cursor to the first letter
where you want to begin highlighting.
2) Hold down the Shift key and press the
right arrow key. You'll actually see
the information being highlighted on the
screen.
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3) Use the copy or cut command on the
highlighted information.
Using the Mouse:
1) Move the mouse to the first letter
where you want to begin highlighting.
2) Click on the left mouse button and
HOLD the button down.
3) Move your mouse to the right. You'll
actually see the information being
highlighted on the screen.
4) Use Select the "Copy" or "Cut"
command under the Edit Menu.

37
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Chapter 5: Commands Menu
The Commands Menu is the pull down menu
equivalent of the ToolBar Menu. It shows
the keyboard equivalent for most of the
ToolBar Menu options. For example,
Ctrl+Home means hold down the Ctrl key
and press the Home key. See the ToolBar
Menu for details
Top Ctrl+Home
(Same as First on ToolBar Menu)
Go to first entry in the file.
Bottom Ctrl+End
(Same as Last on ToolBar Menu)
Go to the last entry in the file.
Next Ctrl+PgDn
Go to the next entry in the file.
Prev Ctrl+PgUp
Go to the previous entry in the file.
Add Ctrl+A
Add a new entry. When you're done,
select "More" to save this one and add
another. Select "Save" to quit adding
and return to view.
Edit Ctrl+E
Edit the current information on the
screen.

38

Chapter 5: Commands Menu

Del Ctrl+D
Click this item to delete the current
information on the screen.
Note: If you have a window at the bottom
of the screen which has the options "New
Change Remove" listed, you'll have to
use "Remove" to delete all the detail
items before you can delete the main
information on the screen.
If you try to delete the information
before using "Remove", a message will
appear and tell you it cannot delete the
information.
Browse Ctrl+B
(Same as List on ToolBar Menu)
Use this option to present multiple
entries in a column and row format.
Normally you'll view about 20 items on
the screen. To get the information to
fill the entire screen, click on the up
arrow in the upper right hand corner of
the screen (Windows 3.x) or click on the
square (Windows 95).
To find an entry in the list, move the
cursor to the field you want to use. For
example, name. Then, begin typing the
first few letters of the name. When you
see the information you want, highlight
it and press <Enter>.
Note: The cursor will only go into
columns where an index is defined. You
will not be able to use this option on
every list column.
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Filter Ctrl+L
See details for the filter command under
the ToolBar Menu, pages 16-19.
Find Ctrl+F
Use this option to find information
already typed into the computer. A Find
Window will appear with the following
options:
"Select Field to Search In:"
Press the space bar or click on the down
arrow to the right to select the
specific field you want to look for. For
example, Grade.
"Enter Value to Search For:"
Enter the information you want to search
for. For example, 10.
"[X] Ignore Case
[ ] Exact Match
Only"
If you want to find exactly what you
type in, select Exact Match, otherwise
leave Ignore Case marked.
Find - Use this option to view the
"First" entry for the information you've
just entered.
Browse - Use this option to choose
from a list of entries that contain the
information you've just entered.
Highlight the entry you want and press
<Enter> to view it.
Count - Use this option count how many
times the information you typed in is
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found in the file. A count will appear
in the upper right hand corner.
Close - Use this option to close the
"Find Window".
Order
This option is similar to the "Order
By:" option of the ToolBar Menu.
However, it brings up the "Change
Viewing Order" window on the screen to
choose the field to order by and the
direction.
To change the view order of the
information on the screen:
a) Highlight the field to use in
ordering the data on the screen.
b) Select "Ascending" or "Descending".
Clear Filter
Select this option to quickly clear all
filters that have been set on the data
you are viewing. If no filters are set,
this option is disabled.
More Ctrl+M
Use this option when you've finished
adding an entry and want to add another
one. The current entry will be saved and
a new screen will appear.
Save Ctrl+S
Use this option to save the information
you've just added or edited. You'll then
return to view mode.
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Cancel
Use this option to quit adding or
editing without saving any changes or
additions.
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Chapter 6: Output Menu (Reports)
This chapter explains how to select and
print reports from the OUTPUT MENU. This
option is Not available if you are
viewing information on the screen. Close
what you're doing and return to the
Master Menu.
Using the Report Query Dialog
All reports, except Catalog Cards and
Barcodes, use what is called a "Report
Query Dialog" to select the information
to print. On these type of reports,
you have a lot of flexibility in
deciding what information to print and
in what order.
First, we'll explain the Report Query
options. Then, we'll provide a couple
of specific examples to better help you
understand this option.
Select your report from the "Output"
option of the Master Menu.
Preview
Select this option to view the entire
report on the screen.
Print
Select this option to print the entire
report to your printer.
Done
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Select this option to exit and return to
the Master Menu.
Selecting Report Information
Use the "Report Query" Window to build
conditions about what data should appear
on your reports.
The following options are available in
the "Report Query" Window.
Field List Box
The box in the upper left hand corner of
the "Report Query" Window lists all the
fields you may select from in order to
limit the information to print out.
For example, do you want to limit the
information you print out by Accession
number, Call Number, Author, etc.
Operator List Box
The box in the upper middle of the
"Report Query" Window displays all the
comparison operator. These operators
vary depending on what type of
information you select. All operators
and their corresponding descriptions are
explained below.
•

Begins With
Finds records where the information
recorded in the computer begins with the
first few letters/numbers you type in.
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•

Is Equal To
Finds records where the information
recorded in the computer equals what you
typed in.
• Contains
Finds records where the information
recorded in the computer contains the
letters/numbers you type in anywhere in
the field you've selected.
For example, suppose you want to print a
new student, but can't remember all of
the name. You do remember that the name
does includes the letters ander
(Anderson). Type in this information.
All student names which have Ander in
their name at the beginning, end, or
middle will be selected.
•

Ends With
Finds records where the information
recorded in the computer ends with the
letters/numbers you typed in.
For example, you know a student's name
ends in the word son, but can't remember
the rest of the name. Select Name, <
Ends with >, and type son. All students
whose name ends with son will be
selected.
• Is In List
Finds records where the information
recorded in the computer is contained in
the list of information you typed in.
Remember to separate each item by a
comma.
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For example, suppose you want a list of
all students whose ID number begins with
96 or 97. Select Student Id, < Is In
List >, and type in: 96,97. Remember,
the comma separates the ID numbers.
• Is More Than
Finds records where the information
recorded in the computer is greater than
the value you typed in under the
"Compare To" box.
Suppose you want to a report of all
students whose Artistic score was
greater than 15. Select the "Career
Interest Survey Scores" report. Select
Artistic, <Is More Than>, and type in:
15
• Is Less Than
Finds records where the information
already recorded in the computer is less
than the value you typed in under the
"Compare To" box.
Suppose you want to a report of all
students whose Job Obstacle score was
less than 12. Select the "List of Job
Analysis Scores" report. Select Jobs,
<Is Less Than>, and type in: 12
• Is Between
Finds records where the information
recorded in the computer is between
values you typed in under the "Compare
To" box. Remember to separate the values
you type in by a comma.
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For example, to limit a report between
Sep 1, 1998 and Sep 30, 1998, you'd
select Date, < Is Between >, and type:
09/01/98,09/30/98 Remember the comma
between the items.
• Year Is
Finds records where the year
recorded in the computer equals the year
you typed in.
• Month Is
Finds records where the month
recorded in the computer equals the
month you selected from the popup list
under the "Compare To" box.
For example, suppose you wanted a list
of all May entries. Select the report.
Select Date, < Month Is >, and select
'May' from the popup list.
• Day Is
Finds records where the day recorded in
the computer equals the day you selected
from the popup list under the "Compare
To" box.
For example, suppose you wanted a list
of all Monday entries. Select the
report. Select Date, < Day Is >, and
select 'Monday' from the popup list.
Note: Most of the time you'll use
< Year Is >, < Month Is >, and < Day Is
> together. Don't forget, to select <
Accept Condition> after each selection.
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•

Is Yes
Finds records where the information
recorded in the computer equals true.
(.T.)
•

Is No
Finds records where the information
recorded in the computer equals false.
(.F.)
Compare To Box
This box is where you type in the
information to use in selecting your
report. In some cases, you'll enter more
than one item. You must separate
multiple items with a comma. See the <
Is In List > example above.
[X] Ignore Case
This option tells the computer to ignore
upper and lower case for anything you
typed in under the "Compare To" box.
Normally, you'll leave this box checked.
It makes it easier to select your
information.
[ ] Negate
Select this box to make the condition
the opposite of what you've just typed
in. Normally, you'll leave this box
blank.
For example, if you wanted all May
entries and then marked this negate box,
your report would contain all entries
except May.
(See < Year Is > example above.)
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[Accept Condition]
This option tells the computer to Accept
what you've typed in or selected. The
condition appears in the "Query
Conditions" box in a descriptive
English-like phrase.
[ ] Output Order
Use this option to select the order in
which to print your report. In some
cases the option will already be marked
[X]. This means the report has already
been set up with a pre-determined
sequence which you cannot alter.
Query Conditions Box
Displays the currently selected
conditions in a descriptive English-like
phrase.
[Add OR]
Use this option to add an "OR" condition
when selecting your report.
For example, suppose you wanted a list
of all 10th OR 11th grade students. To
do this:
1) Select a student report. Select Grade
Id, < Is Equal to >, and type in 10. 2)
Click on < Accept Condition >.
3) Next, click on < Add Or >.
4) Select Grade Id , < Is Equal to >,
and type in 11.
5) Click on < Accept Condition >.
[Remove]
49

Chapter 6: Output Menu (Reports)

To remove one of the conditions you've
entered in selecting your report,
highlight the condition (English-like
phrase) in the Query Conditions box and
select [Remove].
[Clear All]
Select [Clear All] to removes all
conditions from the Query Conditions
box.
[Save]
Use this option to save your Report,
with Query conditions, for future use.
When < Save > is selected you will be
asked to enter a meaningful name for the
report you've created.
[Retrieve]
Use this option to retrieve previously
saved reports and re-use or edit them.
[Printer]
This option brings up the Windows
Printer dialog to select a printer for
your report or label.
[ ] Print Setup Page
Not used.
[PRINT]
Select this option to print the report
to your printer.
[Preview]
Use this option to view your report on
the computer screen. While viewing the
information on the screen, use the
control buttons on the right and the
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scroll bars of the report window to look
over your report:
• Next
Shows the next page of your report.
• Previous
Shows the previous page of your report.
• Page
Use this to select the page to go to.
• Zoom In
Shows specific parts of your report in
close up view.
• Zoom Out
Shows the entire page of your report.
• OK
Select < OK > to exit the screen report.
[Done]
Select this option to exit and return to
the Master Menu.
Output Reports
List of Student Information
This report prints a list of student
information.
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Career Interest Questions
This report prints a list of the
questions used in the Career Interest
Survey.
Job Analysis Questions
This report prints a list of the
questions used in the Job Analysis
Survey.
Career Interest Survey Scores
This report prints the scores, by
student, for each of the twelve major
interest areas. Use it to group students
with similar interests.
List of Job Analysis Scores
This report prints the scores, by
student, for each of the four major job
related areas. Use it to group students
with similar needs and abilities.
List of Job Descriptions
This report prints each job
description with it's associated detail.
Beware, this entire report is for more
than 2,500 job! Limit the information
you print to the printer.
List of GED Reading Codes
This report prints the reading codes
and their descriptions.
List of GED Math Codes
This report prints the math codes and
their descriptions.
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List of GED Language Codes
This report prints the language codes
and their descriptions.
List of Interest Areas
This report prints the twelve major
interest areas used in the Career
Interest Survey.
List of Interest Groups
This report prints the various
interest groups within the twelve major
areas of interest.
Physical Demand Codes
This report prints the physical demand
codes and their descriptions.
List of SVP Codes
This report prints the SVP codes and
their descriptions.
List of Tests
This report prints a list of tests
used by the school.
List of Test Areas
This report prints a list of subtest
areas included on your tests.
List of Test Scores by Test Area
This report prints student test scores
by subtest area.
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List of Test Scores by Student
This report prints student test scores
by student.
List of Course Subjects
This report prints a list of subjects
offered in the school.
List of Student Grades
This report prints a list of grades
for your students.
List of Staff
This report prints information about
staff members in your school.
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Chapter 7: Window Menu
This chapter explains the Window Menu
options. You'll learn how to move a
window on the screen, change it's size,
and select another window on the screen
when more than one is being used.
Move
Keyboard
Press [Ctrl+F7] to move the front most
window on the screen to a different
position. Use the arrow keys to move the
window up, down, left or right. Press
[Enter] when you're done.
Mouse
Click on the very top portion of the
screen with the left mouse button. Hold
the mouse button down and drag the
screen to a different location on the
screen. Let up on the mouse button.
Size
Keyboard
Press [Ctrl+F8] to re-size a window on
the screen. Use the arrow keys to adjust
the size of the window. Press [Enter]
when you're done.
Mouse
Click on the very outside edges of the
screen with the left mouse button. Hold
the mouse button down and drag the
screen, up, down, left, or right to
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change it's size. Let up on the mouse
button when you're done.
Maximize
Keyboard
Use this option with list windows, where
multiple records are on the screen.
Press [Ctrl+F10] to make the current
window on the screen it's maximum size.
Mouse
Click on the up mark (or the box in
Windows 95) in the upper right hand
corner of the window to make it cover
the full screen.
Minimize
Keyboard
Press [Ctrl+F9] to make the current
window on the screen as small as
possible.
Mouse
Click on the Up/down marker in the upper
right hand corner of the List Window to
return to normal size.
Note: Click on the second row of your
screen. The top row of your screen
contains the name of the program. The
second row (to click on) contains the
Master Menu options File, Edit, etc.
Selecting Different Windows on the Screen
The name of all the screens that have
been opened will be listed under the
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Minimize Command. Multiple windows
(files) may be opened at one time.
To make a window current, click on the
name of it with the mouse (under the
Windows Menu) or click on the window
itself on the screen.
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Chapter 8: Utilities Menu
Rebuild Indexes
Use this option when you've had a
computer problem or power failure to
rebuild the indexes of your data
file(s).
To mark one file to be re-indexed, use
the arrow keys to highlight the file and
press [Enter] or double click on it with
the mouse. Notice the arrow markers >>
to the left of the file name.
Mark All
Press [Alt+A] or click on < Mark All
> to mark all data files to be reindexed.
Clear Marks
Press [Alt+M] or click on
< Clear Marks > to unmark all data
files.

Invert
Press [Alt+I] or click on < Invert >
to change all marked files to unmarked
and vice versa.
Select < OK > to reindex the data
file(s) or < Cancel > to return to the
Master Menu.
Erase Deleted Records
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Use this option to erase all deleted
entries in a file.
When you use the Delete option [Ctrl+D],
the entry on the screen is marked for
deletion and you no longer see it on the
screen. However, it is physically still
on your hard disk. This option
physically erases all entries marked for
deletion. They'll be gone forever!
To mark a file (in order to erase
deleted records), use the arrow keys to
highlight it and press [Enter] or double
click on the file with the mouse. Notice
the arrow markers >> to the left of the
file name.
Mark All
Press [Alt+A] or click on < Mark All
> to mark all data files for deleting
records.
Clear Marks
Press [Alt+M] or click on < Clear
Marks > to unmark all data files.

Invert
Press [Alt+I] or click on < Invert > to
change unmarked files to marked and
vice versa.
Select < OK > to erase the deleted
records in the selected data file(s) or
< Cancel > to return to the Master Menu.
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Update File Structure
Use this option to update the structure
of a data file when you receive updates
to the program. You'll receive
instructions with your update on which
file(s) to select.
Press the [Spacebar] and use the arrow
keys to highlight the file or click the
mouse on the down arrow to the right of
the filename box and click the data file
to be updated.
Select < OK > to update the file or <
Cancel > to return to the Master Menu.

Program Preferences
Use this screen to enter the following
information:
Select the type printer you'll use for
printing reports in the Printer box.
[1] = Laser Printer
[2] = Dot Matrix Printer
Select your computer's Printer Port.
Normally, this is LPT1. When in doubt,
select this option.
Tell the computer whether to turn the
Century on.
When marked [X], the reports and screen
will show dates in the format:
09/01/1998.
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When not marked [ ], the reports and
screen will show dates in the format:
09/01/98.
For the Year 2000 and beyond, you will
have to have the century box marked [X].
Redo Career Interest Scores
Use this option to re-post all Career
Interest Scores. This information is
maintained in each student's file. If
you have a power failure or equipment
problem, it's possible that these scores
did not get posted correctly.
This option will verify and correct all
Career Interest scores for each student,
where needed.
Redo Job Analysis Scores
Use this option to re-post all Job
Analysis Scores. This information is
maintained in each student's file. If
you have a power failure or equipment
problem, it's possible that these scores
did not get posted correctly.
This option will verify and correct all
Job Analysis scores for each student,
where needed.
Change Password
This screen will allow you to change
your password. You must first enter the
current password. Then you can enter
your new password. You must then enter
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the new password again to insure
accuracy.
Backup/Restore
Use this option to backup and restore
your program file information to floppy
diskettes or to the backup directory of
your harddisk.
Be sure to use floppy diskettes on a
regular basis. If you only backup to
your harddisk and it crashes, you'll
LOOSE ALL YOUR DATA!
You must tell the program whether to
backup or restore your date.
You must tell the program where the data
is, i.e., floppy drive A or B, or on
your harddisk.
Copy From School Office
Use this option to copy information from
the School Office program to the Careers
and Jobs program. If the identical
information already exists in the
Careers program, it will not be copied
again and duplicated.
Select the information you wish to copy
by clicking on the circle to the left of
the listed information.
Enter the drive and path to the School
Office program. By default, this is:
C:\SCHW.
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Export File
Use this option to copy information from
your computer to a floppy disk drive.
For your information, the data will be
copied using the ASCII format.
Follow the steps on the screen:
1) Select the file that you want to copy
to a floppy diskette. Use the arrow
keys or mouse.
2) Put a blank formatted diskette in
floppy drive A or B.
3) Enter the disk drive and path for
your data. For example: A:MYFILE.TXT
4) If you do not want to copy the entire
contents of the file to a floppy
diskette, select Yes when prompted "Do
you want to set a filter?" (See the
example below.)
You must then select the field for the
program to look at to determine what
information to copy. For example, if you
wanted to copy students in grade 10:
You'd select the Student file.
When the "Filter" window appears you'd
select "Grade Id" as the "Field to
Search In".
Next, select 'Equals to".
grade: 10
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Click on "Set". The program will tell
you how many matches (students) were
selected. Click on "Close".
5) Select the fields to export Window
At this point you may copy any or all of
the fields in the selected file.
Click on "Select All" to copy all the
information to a floppy diskette. All
the fields in the box on the left will
appear in the box on the right. The box
to the right shows all the data fields
to be copied.
To select individual fields, double
click on a field in the box to the left.
It will appear in the box on the right.
NOTE: If you only want to copy certain
fields, it's very important that you
copy them in the order you want them to
be written on the disk. If another
program has some of the same information
(and can import data), be sure you
select the fields you want in the order
you want.
If you make a mistake or change your
mind, use the "Deselect All" to remove
all fields to be copied or the
"Deselect" option to remove one field
from the box on the right.
Select OK to copy the selected
information to the floppy diskette.
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Select Cancel to exit and return to the
Master Menu.
Import File
Use this option to copy information from
a floppy diskette to your computer. For
your information, the data will be
copied using the ASCII format.
Follow the steps on the screen:
1) Select the file that you want to copy
into from the floppy diskette. Use the
arrow keys or mouse.
2) Put the data diskette in floppy drive
A or B.
3) Enter the disk drive and path for
your data file. For example:
A:MYFILE.TXT
4) Select the Fields to Import Window
At this point you must tell the computer
which fields are on the floppy disk file
and the sequence in which those fields
were written to the floppy diskette.
Click on "Select All" to copy all the
information in the file from the floppy
diskette. All the fields in the box on
the left will appear in the box on the
right. The box to the right shows all
the data fields to be copied to your
computer from the floppy diskette.
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To select individual fields, double
click on a field in the box to the left.
It will appear in the box on the right.
NOTE: If you only want to copy certain
fields, it's very important that you
tell the program the order in which the
fields were written onto the disk.
If you make a mistake or change your
mind, use the "Deselect All" to remove
all fields to be copied or the
"Deselect" option to remove one field
from the box on the right.
Select OK to copy the selected
information from the floppy diskette to
your computer.
Select Cancel to exit and return to the
Master Menu.
Registration/Support
Register the Program
To gain unrestricted access to the
program, you must register it. To
register a program, do the following:
1) Received the Master Diskettes
If you ordered the program from our
office, the registration information
will be on the last master diskette.
Put that diskette in your floppy disk
drive (A or B).
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Under the Utilities Menu, select
‘Registration/Support’, then select
‘Register Program’.
By default, the program is set up to
register the program from floppy disk
drive A. If this is what you want to do,
simply select < OK >. Otherwise, select
the appropriate options below.
From the Program Registration Screen:
Select (•) Register Program
( ) Un-Register the Program
Select the program to register:
(•) Careers and Jobs Program
( ) All-In-One Registration
Select the drive where the registration
information is located:
(•) Registration File is in Drive A
( ) Registration File is in Drive B
( ) Other DrivePath (Please specify)
Note: If you select this last option,
you must type in the drive and path
where the registration information is
located. For example: c:\windows\temp
(Be sure to enter the location where the
registration file is located on your
computer.)
2) Registering the Demo program
Downloaded from our Web Site.
If you downloaded the demo program and
want to purchase it, contact our sales
office: 1-800-424-7512 or email us at:
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sales@epessoftware.com. When the payment
or purchase order is received, you will
be sent a registration file for the
program. Put that file on a floppy
diskette and follow the same
instructions in step 1 above.
Update Support
Use this option to update your support
renewal information for the program. You
will receive a support renewal code from
our office when you support is renewed.
Note: If you purchased the All-In-One
option, you will renew your support each
year. If your support is not renewed
within 30 days after the completion of
the year, the program will return to
Demo mode.
Select the program to update:
(•) Careers and Jobs Program
( ) All-In-One
Support Renewal Code: Enter the support
renewal code you received from our
office.
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Chapter 9: Help Menu
About
The first screen of the About Dialog
displays the application name and
author.
To move to the next screen, select the
"More" push button. To exit the About
dialog, select the "OK" push button.
The second screen of the About Dialog
displays the following information:
Resource File: Location of the
application resource file.
Configuration File: Location of the
application configuration file read when
the application was started.
Home Directory: Directory where the
application was loaded from or where the
application support libraries are
stored.
The third screen of the About Dialog
displays the following information about
the current hard disk:
Available Diskspace: Total amount
of free disk space on the current drive.
Temporary File Drive: Location
where temporary files are created.
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Temporary File Space: Total amount
of free disk space on the temporary file
disk drive.
Temporary File Disk Size: Total
disk space on temporary file disk drive.
Current Directory: Default
directory.
The fourth screen of the About Dialog
displays the following environment
information:
Operating System: The operating
system and version in use.
Comspec: Location of COMMAND.COM.
Windows Directory: The directory
where Microsoft Windows (tm) is
installed. This information is only
displayed if the application is being
run from within Windows.

use

Processor: The type of processor in
on your computer.

FoxPro Version: Version of FoxPro
in use.
Version Date & Time: The Date and
Time stamp of the version of FoxPro.
The last screen of the About Dialog
displays the following memory
information:
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Total Available Memory: Total
amount of available system RAM in
Kilobytes
Remaining Available Memory: Total
amount of remaining RAM in Kilobytes
Available DOS Memory: Amount of DOS
memory available in Kilobytes
Current Memory Usage: Amount of
memory currently being used in Kilobytes
EMS Memory In Use: Amount of
Extended memory currently in use
Contents F1
This option displays the Help window.
This is the built in "Help" system for
your program.
If you are on a specific item in the
program and press F1, you'll get help
about that item.
If the screen is blank and or specific
help item is referenced, a list of help
topics will appear. To get to a
specific topic in the list, begin typing
the first few letters of the topic.
Then, highlight the topic you want and
press <Enter> to get specific help about
that topic. Use the arrow keys, PageUp
and PageDown keys to view the
information on the screen or use the
mouse on the scroll arrows to the right
of the box.
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Help Window Options
(when viewing a specific topic)
The help window has five commands (on
the left of the help window). These are:
1.

Topics
Press [T] for Topic or click on
Topics with the mouse. A list of all
the help topics available in the program
will appear in a list form. To get help
on a specific topic, begin typing the
first few letters of the topic you want.
Use the arrow keys to highlight the
topic and press <Enter> or click on it
with the mouse . The detailed
information about that topic will be
displayed.
2.

Next
Press [N] or click on < Next> with
the mouse to move to the next help topic
in the topics list.
3.

Previous
Press [P] or click on < Previous>
with the mouse to move to the previous
help topic in the topics list.
4.

Look Up
You can highlight a key word in the
help window when you're viewing the
information about a specific topic.
Then, click on < Look Up > to see if
there are any references in the help
file for that word.
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5.

See Also
Use this option when viewing
information about a specific topic to
look up a "Cross Referenced" related
topic. To select this option press [S]
or click on <See Also> with the mouse. A
list of related topics will appear, if
available. Type the first letter(s) of
the topic you want to see. Use the arrow
keys to highlight the related topic or
click on it with the mouse to go to that
related topic.
Note: To return to the Topic(s) you've
already viewed, press [S] again. Notice
the line dividing the 'See Also' box.
The topics above the line are ones
you've already viewed. The topics below
the line are topics still available for
view. Highlight the topic you want to
see and press [Enter] or click on it
with the mouse.
To Exit Help, press the <Esc> key or
click the mouse in the upper left and
corner to clear the help window.
On Line Manual
This screen provides the instrutions on
how to get the most current documenation
of the program from our web site.
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This is a blank page.
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Chapter 10: Administrator Menu
Administrator
This chapter explains the Administrator
Menu options. This Menu will only appear
when the System Administrator is logged
in. When you first installed this
program, the instructions explained how
to log into this program as the System
Administrator:
ID: SYS
PASSWORD: PASSWORD
This is the ID and Password for the
System Administrator when you receive
the program.
The System Administrator has total
access to everything in the program. As
the System Administrator, you'll use the
Administrator Menu options to enter
additional users for the program. You
can also change the password, under the
'Change Password' option of the
Utilities Menu.
User Information
Use this screen to change all rights a
specific user has when using the
program.
One person must have total rights to
everything in the program. This person
is called the 'System Administrator'. If
only one person is using the program,
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this person should log in as the System
Administrator.
The System Administrator uses this
option to:
1) Add new users for the program.
2) Give Add, Edit, Delete, and View
rights to each user.
3) Assign Group Managers.
4) Change individual user's
password.
Adding New Users to the Program
Press [Ctrl+A] or click on < Add > with
the mouse to add a new user. A blank
"User Information" window will appear.
Enter the following information:
First Name: Enter the first name of the
user. For example, John.
[Last Name: Enter the last name of the
user. For example, Doe.
User Id: Enter a three letter user ID
for this person. The initials of the
person are often used. However, this is
a unique field. If two people have the
same initials, you must make them
different in some way. For example, LDA
or LA2.
Password: Enter the user's password. The
user may change his/her password from
the 'Change Password' of the Utilities
Menu. However, as the System
Administrator, you will always be able
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to view the user's password from this
option.
Group: If you want groups of people to
use the same data files and have the
same rights, enter a group name. For
example, STUDENT.
Once you've set up all the rights for at
least one member of this group as
explained in this chapter, you may add
another person and enter their group as
STUDENT. This new individual will have
all the same rights you've previously
set up for the student group... without
going through the "Rights" options for
every file again.
System Administrator: One person is
assigned the System Administrator. This
was already set up for you when you
installed the program. The User ID was
'SYS' and the Password was 'PASSWORD'.
Group Manager: If you assign groups of
users, you may assign one or more users
as Group Managers.
The Group Manager may add new users and
assign rights to this new user. However,
the Group Manager cannot assign rights
he/she does not have. The Group Manager
doesn't necessarily have all the rights
of the System Administrator.
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For example, a Group Manager may have
all rights with respect to STUDENT, but
no rights for any other group.
If a group manager is logged in, the
Administrator Menu will appear on the
Master Menu.
Rights: Use this option to assign
individual rights to each user. This
option determines whether a user may
add, edit, or even view information in a
file.
This option is available when you are
adding or editing information about a
user.
Press [Ctrl+A], [Ctrl+E], or click on
< Add > or < Edit >.
Use the arrow keys to highlight the file
you want to assign user rights on, and
press [Enter] or double click on the
file.
A "User Rights" window will appear.
Use the box at the top of the "User
Rights" Window to assign the rights a
user may have in this file.
These rights are explained below. To
assign rights, click on it with the box
or press the underlined letter of the
option. When the button to the left of
the option is filled, it means this is
the right the person has to this file.
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•

Full Access - This allows the users
to add, edit, or change any
information in this file.

•

Read Only - This allows the user to
see information on the screen, but
he/she cannot add, edit, or change
any information.

•

Add Only - This allows the user to
see the information on the screen and
add new records to the file.

•

Edit Only - This allows the user to
see the information on the screen and
edit existing records to the file.

•

Add + Edit (No Delete) - This allows
the user to see the information on
the screen, add new records, or edit
existing records. However, this
person may not delete any
information.

•

No Access - This option prevents the
user from even viewing the
information in the file.

Note: Ignore the box at the bottom of
the "User Rights" screen. Restricted
Access information is not used in your
program.

System Reports
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User List
This option prints a list of users for
the program.
Printer Setup - This option takes you to
the Windows Printer Setup Dialog to
change printers, if needed.
Print - This option prints the List of
Users to your printer.
Preview - This option prints the List of
Users to the screen.
Done - Select this option to return to
the Master Menu.
Error Log
Select "System Reports" under the
Administrator Menu. Press [E] or click
on "Error Log".
This report prints any problems that
occurred while using the program. This
is primarily used by the System
Administrator and technical support for
trouble shooting.
Printer Setup - This option takes you to
the Windows Printer Setup Dialog to
change printers, if needed.
Print - This option prints the List of
Users to your printer.
Preview - This option prints the List of
Users to the screen.
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Done - Select this option to return to
the Master Menu.
You will be asked whether you want to <
Clear the error log file > upon exit.
Select < Yes > and the information in
this error file will be erased.
Note: Once a problem is resolved, there
is no need to keep the information on
file.
Peer to Peer Networks
On peer to peer networks, like
Lantastic, you will need to make certain
files READ ONLY if more than one person
is to use the program at the same time.
The current EPES Software programs for
Windows are written using the FoxPro
database language. One of the programs
you'll have in your main directory after
installing the program is called:
FOX2600.ESL. This program will be shared
by all users. To do this on a peer to
peer network, go to the directory where
the program was installed. For example:
F:\CAW.
Type the following: ATTRIB +R
FOX2600.ESL and press <Enter>.
You'll also need to do this for the main
program. It ends in the suffix .EXE.
For example, on the School Accounting
Software program, this file is called:
CAW.EXE.
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Type the following: ATTRIB +R CAW.EXE
and press <Enter>.
Installing the Program a Second Time
If you have to install the software
again, for any reason, after you've made
these files READ ONLY as explained
above, do the following:
1) Be sure no one is using the program.
That means get everyone to exit the
program.
2) Go to the directory where the program
is installed. For example: F:\CAW
3) Type: ATTRIB -R *.* and press
<Enter>.
Now you can install the software again.
When you're done, you must make the
Fox2600.ESL and CAW.EXE files READ ONLY
as explained above if you want more than
one person to access the program at the
same time.
If you do not follow these steps, you'll
get an error message "Permission
Denied", when you install the software
again.
Enter any notes that will help you with
the program here.
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